no Pain no Gain no Gavin & [F>b T4 : http://blog.sina.com.cn/deaboway http://blog.csdn.net/deaboway

—. HRAEE
1. Android Fjf}

Android J& Google T 2007 4= 11 H 5 HE A MHEET Linux V& TR T-H1#
ERG I, 2 mBAERS. haE. AP SRSy /A, 5702
AN A B) A $ T 3E 1 30 IE T RO e BE AL B R AF o vl A e o] B B AR i Linux
BT —A JAVA )52,

Android MFHEEAR PR, BEARATD BUAESEEESERWH, HX
4 2 BRI 4x - Android IARF AT LUK JAVA JFA, PUAEIEFIPL (Virtual
Machine) Dalvik, HZE JAVA [f] bytecode ¥Rk H CiIR&, o] 75 24}
25 SUN 5% JAVA #2823 . Ak, Android JFAIMEEZTFHE JDK 1,

2. Android MZE%E
Androidf M uh4&: http://www. android. com/, HRIIARLLERE, Eoi k]
42 : HPartnersiifi4r: http://source. android. com/FDevelopersiiisy:
http://developer. android. com/, KX & Tcikviml .
Androidff) ARG EKIE S % .
http://androidappdocs. appspot. com/sdk/requirements. html

METBCHT A IAndroid SDK F#k#s (ELIEMISDKIS &7 E 54N R4t , /b
A T0TE HE R M http://developer.android.com/sdk/index.html " #fr), Ti&
FANE T —ANHibkhttp: //androidappdocs. appspot. com/sdk/index. html, %
BEFEAIULEA AR

Android SDK for Windows
android-sdk_r08-windows.zip
http://dl.google.com/android/android-sdk_r08-windows.zip
installer_r08-windows.exe (Recommended)
http://dl.google.com/android/installer_r08-windows.exe
Android SDK for Mac OS X (intel)
android-sdk_r08-mac_86.zip
http://dl.google.com/android/android-sdk_r08-mac_86.zip
Android SDK for Linux (i386)
android-sdk_r08-linux_86.tgz
http://dl.google.com/android/android-sdk_r08-linux_86.tgz
Here's an overview of the steps you must follow to set up the Android SDK:
1. Prepare your development computer and ensure it meets the system
requirements.
2. Install the SDK starter package from the table above. (If you're on Windows,
download the installer for help with the initial setup.)
3. Install the ADT Plugin for Eclipse (if you'll be developing in Eclipse).
4. Add Android platforms and other components to your SDK.
5. Explore the contents of the Android SDK (optional).
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http://developer.android.com/
http://androidappdocs.appspot.com/sdk/requirements.html
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http://androidappdocs.appspot.com/sdk/index.html
http://dl.google.com/android/android-sdk_r08-windows.zip
http://dl.google.com/android/installer_r08-windows.exe
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3. MAETE

a. JDK 1.6

AR
http://www. oracle. com/technetwork/ java/javase/downloads/index. html

AT A A Java SE 6 Update 23

INENLAS B g jdk1. 6.0 21, tH—FEH, s RS JDKL. 5 Bk
FATLL T .

b. Android SDK |##%

TEHhE B O T, DRI R RGIEREA R el . NER
windows 2003 server, K TF# 7T
http://dl.google.com/android/android-sdk_r08-windows.zip, < & H M L4680 ],

c. Eclipse IDE

Eclipse 3.4 (Ganymede) LA J FRAI T o /NN T i A Y Helios (3.6)

—. JAVAIRIE
Windows Lt JAVA BREEASEA1 R
JAVA HOME
oA P SR VN 1 . | = = 8 o ol = B 0
|
TEE (H): TAVA HOME
FH{E (V) DY javahjdkl. 6.0_21
[ wWE ] [ Hoid ]
FIRTEE)
TE (11
FF_HO_HOST C... MO
JAVA_HOME D: % javahjdkl. 5.0_Dd E|
WUMEEE_OF FR... 1
oz Windows_ HT
Fath DM java JavaFXh javafu—=dlel . 3hbi. ..
gEw || B0 || #ko |
| wmE || B |
Path:


http://www.oracle.com/technetwork/java/javase/downloads/index.html
http://dl.google.com/android/android-sdk_r08-windows.zip
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x|

Path

whin; %TAVA_HOME%hbin; D Yjavaieclipse

[ wmx | [ mm

)

=. Android SDK %3t

Android SDK T] LLliiE SDK T#i8% B3 FEAEE, EEMEE, FEE
BB OT; W MEB T E T SDK XX, FTRE, &4 MNEAN 2RI,

TEEEBEELT.

SDK T & B T8 BRI T :
1. it 45 android-sdk_r08-windows F#&#%, JFX 21T SDK Manager.exe:

File Edit  Wiew

@Back @ \_/l

Favorites  Tools

l.ﬁ pSearch “. Folders v

& F:\android\android-sdk-windows

Help

File and Folder Tasks

@ Renarne this file

C@ IMowve this file

Copy this file

&N Publish this file to the Weh
(=) E-mail this file

¢ Delete this file

Other Places

() android

My Documenks
:i Iy Computer
‘ﬂ [y Metwork Places

Details

SDK Manager.exe
Application

Date Modified: 2010811 B 17
B, 18:51

Size: 353 KB

address |23 Fi\android\android-sdk-windaws

v|Go

Mame
I add-ons
) platforms
) toals
'ﬁ' SDK Manager.exe

[£] 5ok Readme bt

Size:

354 KB
LKEB

Type

Folder

Folder

Folder
Application
Texk Dacument

Date Modified
2011-1-3011:38
Z011-1-30 11:38
2011-1-3011:35
2010-11-17 18:51
2010-11-30 19:34
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{3 Android SDK and AVD Manager

Wirkual Devices

Installed Packages
Available Packages
Settings

About

5Dk Location: I

Installed Pac
I Andraid 50
i1 SDK Platfa
i1 SDK Platfa
i SDK Platfa

Description

Il Refresh Sources

Fetching https: ffdl-ssl. google. com/androidrepository frepository <ml

[..--..-.--..-.-----.--.--.------------.---.-.-] Close

Failed to Fekch URL https: ) fdl-ssl.google, comfandroidfrepository frepository, xml,

setkings.

reason: HTTPS S50 error. You might want to Force download through HTTP in the

Update All...

Delete, .,

T $E setting 16+ Force https://... Sources to be fetched by using http://... )ik

KA

& Android SDK and AVD

Manager

Wirkual Devices
Installed Packages

A ailable Packaies

About

Proxy Setkings

Misc

HTTF Prowy Server |
HTTP Proxy Part |

| [“Farce https:fi... sources b be Fetched using httpyff...  Bhttp=lEER 1 Akt tpiElE

sk before restarting ADE

Save & Apply

2. AJIERARE 25K Packages, Jfs5ili Install Selected AT 4%
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3 Android SDK and AVD Manager

Wirtual devices SDK Location: F:handroidiandr oid-sdk-windows
Installed packages
B

Packages available For download

]

Android Repository

] I Android SDK Tools, revision 9

¥ android SDK Platfarm-tools, revision 2

Documentation For Android 'Honeycomb' Preview SDK, revision 1

About

[

S0k Platform Android Honeycomb Preview, revision 1
S0k Platform Android 2.5.1, APT 9, revision 2

SDK Platform Android 2.2, AP &, revision 2

SDK Platform Android 2.1, APT 7, revision 2

SDFK Platform Android 1.6, AP 4, revision 3

SOk Platform Android 1.5, AP 3, revision 4

& Samples For SDK APT Honeycomb Preview, revision 1

O
O
O
O

& Samples for SDK APT 9, revision 1
O & Samples For SDK APT 8, revision 1

Samples For

1 [ P B Y Y R A 0 2

W Google Inc. add-ons (di-ssl. google. cam)

'if. Google APIs by Google Inc., Android AP 9, revision 2

'Ef. Google APIs by Google Inc., Android AP 9, revision 1

O 'E;. Google APIs by Google Inc., Android API 8, revision 2

O 'Ef. Google APIs by Google Inc., Android API 7, revision 1

O 'E‘. Google APIs by Google Inc., Android APT 4, revision 2

O 'ﬁ. Google APIs by Google Inc., Android APT 3, revision 3
@ Google Ush Driver package, revision 4

m Gongle Market Licensing package, revision 1

2] a Samsung Electronics add-ons {innovator, samsungmobilz, com)
-] 'Ef. GALARY Tab by Samsung Electronics., Andraid APT &, revision 1

[ A

[

Description
Android SDK Samples for Android APT 7, revision 1

Add Add-on Site... Display updates only Install Selected

3. FRUEHERNEDN R, ¥E$% Accept All FEAT R 822

% Choose Packages to Install

Packages Package Description & License
" SDK Platform Android 2.3.1, APT 9, revision 2 [*] Packaqe Description ~
~ Samples for SOK APL 9, revision 1 .ﬁ.nd_ro_id SDK Platform 2.3.1_r2 T
" Google APIs by Google Inc., Android API 9, rev... REHETE &
" Google Usb Driver package, revision 4 Dependencies
~ Google Market Licensing package, revision 1 This package is 4 dependency for:

- Google APIs by Google Inc., Android APT 9, revision 2

Archive Description

Archive For any 05

Size: 75 M

SHA1: 209f8a7agb2cb093fce858babeSfed3bas 206773

Site
andrnid Rennsitary (dl-=s1.nanale . ram

O Accept D Reject

Inskall H Cancel ]

4. I Android SDK #2810 N #2228 ) il F
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B Installing Archives @

Downloading S0 Platform android 2.3.1, APT 9, revision 2 (1%, 356 KiB's, 3 minutes lef

[ | [ Cancel |

Downlaading SOK Platform Andraid 2.3.1, API 9, revision 2

5. MRAEVRE IO, F BRI N T B Bk, 1S I OS54

FEHTESBNT:

1. @S #rAndroid &2
http://dl-ssl.google.com/android/repository/repository.xml Py 2%, 7] L1520
T R#E4E (LLWindowsI R 4]

http://dl-ssl.google.com/android/repository/android-1.5_rO4-windows.zip
http://dl-ssl.google.com/android/repository/android-1.6_r03-windows.zip
http://dl-ssl.google.com/android/repository/android-2.0_rO1-windows.zip
http://dl-ssl.google.com/android/repository/android-2.0.1_rO1-windows.zip
http://dl-ssl.google.com/android/repository/android-2.1_r02-windows.zip
http://dl-ssl.google.com/android/repository/android-2.2_r02-windows.zip
http://dl-ssl.google.com/android/repository/android-2.3.1_r02-linux.zip
http://dl-ssl.google.com/android/repository/android-3.0_pre_r01-linux.zip
http://dl-ssl.google.com/android/repository/platform-tools_r02-windows.zip
http://dl-ssl.google.com/android/repository/tools_r09-windows.zip
http://dl-ssl.google.com/android/repository/docs-Honeycomb_pre_rO1-linux.zip
http://dl-ssl.google.com/android/repository/samples-Honeycomb_pre_rO1-linux.zip
http://dl-ssl.google.com/android/repository/samples-2.1_rO1-linux.zip
http://dl-ssl.google.com/android/repository/samples-2.2_r01-linux.zip
http://dl-ssl.google.com/android/repository/samples-2.3_rO1-linux.zip

2. HAEHI N ECCR N AERIA, IFL R OC R iR IS 40 B SDK R 3t Pt
FEH S, WU ICRT

android-1.5_r04-windows.zip platforms\android-3
android-1.6_r03-windows.zip platforms\android-4
android-2.0_r01-windows.zip platforms\android-5
android-2.0.1_r01-windows.zip platforms\android-6



http://dl-ssl.google.com/android/repository/repository.xml
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android-2.1_r02-windows.zip platforms\android-7
android-2.2_r02-windows.zip platforms\android-8
android-2.3.1_r02-linux.zip platforms\android-9
android-3.0_pre_r01-linux.zip platforms\android-10
platform-tools_r02-windows.zip platforms-tools
tools_r09-windows.zip tools
docs-Honeycomb_pre_r01-linux.zip doc
samples-Honeycomb_pre_r01-linux.zip | samples\android-10
samples-2.1_r01-linux.zip samples\android-7
samples-2.2_r01-linux.zip samples\android-8
samples-2.3_r01-linux.zip samples\android-9

3. W EHigoogle api, AT N E PR
http://dl-ssl.google.com/android/repository/addon.xml % B 75 2L K

PackagesiFATi# Ik, J7ikA 1. 2

3 Android SDK and AVD Manager

Hirtual devices SDK Location: F:landroidiandroid-sdk-windows
Installed packages

Awvalable packages Packages available for download

Settings = : :

about & = Android Repository

[

I android DK Taals, revision 9
i Documentation For Android 'Honevcamb' Preview SOK, revision 1
SDK Platform Android Honeycomb Preview, revision 1
30K Platform Android 2.3.1, API 9, revision 2
SDK Platform Android 2.2, APT 8, revision 2
30K Platform Android 2.1, API 7, revision 2
SDK Platform Android 1.6, APT 4, revision 3
SOK PlatForm Android 1.5, API 3, revision 4
& Samples for SDK APT Honeycomb Preview, revision 1
& Samples for SOE APT 9, revision 1
& Samples for SOK APT &, revision 1
& Samples Far SDE AP 7, revision 1

L B 1 1 B 1 O 1 B 1y O
EEEEEEIE

[ R

[ )

ol
]

R 'Ej. Google APIs by Google Inc., Android APT 9, revision 2
ER 'Ej. Google APIs by Google Inc., Android APL 9, revision 1
R 'Ej. Google APIs by Google Inc., Android APL 8, revision 2
#- ] 'Ej. Google APIs by Google Inc., Android AP 7, revision 1
R 'Ej. Google APIs by Google Inc., Android APT 4, revision 2
#- ] 'E]. Google APIs by Google Inc., Android APT 3, revision 3
-] =] Google Usb Driver package, revision 4
=] Dm Google Market Licensing package, revision 1
-] u Samsung Electronics add-ons {innovator.samsungmobile, com)
@] 'E]. GALAXY Tab by Samsung Electronics., Android APT 8, revision 1

Descripkion

Add-on Provider: Google Inc, add-ons
[Add-on URL: https:[fdl-ssl.google. com/androidfrepasitary faddon, xrml |

Add Add-on Site. .. Display updates only | Refresh | | Install Selected

NESIERN
http://dl-ssl.google.com/android/repository/google_apis-3-r03.zip
http://dl-ssl.google.com/android/repository/google_apis-4_r02.zip
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http://dl-ssl.google.com/android/repository/google_apis-5_r01.zip
http://dl-ssl.google.com/android/repository/google_apis-6_r01.zip
http://dl-ssl.google.com/android/repository/google_apis-7_r01.zip
http://dl-ssl.google.com/android/repository/google_apis-8 r02.zip
http://dl-ssl.google.com/android/repository/google_apis-9_r02.zip
http://dl-ssl.google.com/android/repository/market_licensing-r01.zip
http://dl-ssl.google.com/android/repository/usb_driver_r04-windows.zip

4. WUNRAN:

google_apis-3-r03.zip add-ons\addon_google_apis_google_inc_3
google_apis-4_r02.zip add-ons\addon_google apis_google_inc_4
google_apis-5_r01.zip add-ons\addon_google_apis_google_inc_5
google_apis-6_r01.zip add-ons\addon_google apis_google _inc 6
google_apis-7_r01.zip add-ons\addon_google_apis_google_inc_7
google_apis-8 r02.zip add-ons\addon_google_apis_google_inc_8
google_apis-9_r02.zip add-ons\addon_google _apis_google_inc_9
market_licensing-r01.zip google-market_licensing
usb_driver_r04-windows.zip | usb_driver

5. FARMN H 4ty ~ A
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= I3 android-sdk-windows
= |2) add-ons

¥

| # F

F

) addon_google_apis_google_inc_3
IZ) addon_google_apis_google_inc_4
) addon_google_apis_google_inc_5
I} addon_google_apis_google_inc_6&
) addon_google_apis_google_inc_7
) addon_google_apis_google_inc_8&
) addon_google_apis_google_inc_9

+ ) docs
+ ) google-market_licensing
= I} platforms

F

e

) android-3
2 android-4
) android-5
2 android-a
) android-7
) android-3
) android-2
+ ) data
) images
+ ) skins
) templates
+ | ) tools
) android-10

+ ) platform-tools
=l I} samples

F

Fe

F

¥

) android-7
2 android-g
) android-2
2 android-10

+ ) temp
+ ) tools
+ |2 usb_driver

x

Tarne Size

~ |yadd-ons

Jdocs
[Jgoogle-market_licensing
Jplatforms
[Jplatform-tools
Jsamples
)temp
ZJtools
Jush_driver

S0K Manager.exe
[Z] =Dk Readme bxt

354 KB
1 KB

Type
Folder
Folder
Folder
Folder
Folder
Folder
Folder
Folder
Folder
Application
Text Docurment

Date Modified
2011-1-30 1447
2011-1-3015:02
2011-1-3015:05
2011-1-3015:06
2011-1-3011:51
2011-1-30 14:49
Z2011-1-3015:05
2011-1-30 14:47
2010-12-6 20047
2010-11-17 18:51
2010-11-30 19:34

6. fiRILSEMUE A3~ | SDK Faidy, AL ety, K.



no Pain no Gain no Gavin & [F>b T4 : http://blog.sina.com.cn/deaboway http://blog.csdn.net/deaboway

% Android SDK and AVD Manager =1E]

virtual devices SDK Location: F:landroid|andraid-sdk-windows
fevailable packages Installed packages

Sekki

nebnﬂgs I Android SOK Tools, revision 9

¥ Android SDK Platform-toals, revision 2

it Docurnentation For Android 'Honeycomb' Preview SDE, revision 1

SOK, PlatForm Android 2.3.1, APL 9, revision 2

SOK, PlatForm Android 2.2, APT &, revision 2

SDK Platform Android 2. 1-updatel, APT 7, revision 2

SDK Platform Android 2.0.1, API 6, revision 1

SDK Platform android 2.0, APT S, revision 1

SDK PlatForm Android 1.6, APT 4, revision 3

SDK, PlakForm Android 1.5, APT 3, revision 4
db Samples For SDK API Honeycomb Preview, revision 1
& Samples For SOK APL 9, revision 1
& Samples For SDK AP 8, revision 1
& Samples For SDK APL 7, rewvision 1
'E]..Gu:u:ugle APIs by Google Inc,, Android APT 9, revision 2
'E.ch:ugle APIs by Google Inc,, Android AP &, revision 2
'E.Google APIs by Google Inc., Android APT 7, revision 1
'E.Google APIs by Google Inc., Android APT &, revision 1
'E.Google APIs by Google Inc., Android APT 5, revision 1
'E].Google APIs by Google Inc., Android APT 4, revision 2
'E].Gaagle APIs by Google Inc,, Android APT 3, revision 3
58 Ush Driver package, revision 4
=1 Google Market Licensing package, revision 1

Cescripkion

Update all...

Ve I P EFF G S IR, Android A/ 7 Android SDK Platform
Honeycomb Preview, revision 1, 74414 # #% android-3.0_pre_r01-linux.zip (7%
http://dl-ssl.google.com/android/repository/android-3.0_pre_r01-linux.zip, ZrL{ Z7H#/
LT LR AT Android SDK, /4405 SDK 18/ 15 5107 77 T #«
Fo

PU. Eclipse £ERJF K3 (IDE) ##

IAE T4 Eclipse IDE & Android Eclipse plugin ()25 FIRd &, 3% HLA8 1)
Eclipse i<, eclipse-java-helios-SR1-win32.zip, i 4473 Eclipse ‘B J5 ®
(http://eclipse.org) b R & A O MK RRAS, #i% 3.4 DLEFRA.

FATM¥ A K Android Eclipse Plugin & ADT: Android Development Tools.
Al Android SDK —#¥, 2 ATELLZEM T3 LB T R

LTI BT

1. FIJF Eclipse, LK. Help->Install New Software...

10
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YWeloome
(7) Help Contents

&7 search
Crynamic Help

Key Assist... Zkrl+Shift+L

Tips and Tricks, ..
E}" Repart Bug or Enhancement. ..
Cheat sheets. .,

Check for Updates

Inskall Mew Software. .,

Eclipse Marketplace. ..

about Eclipse

2. B “Available Software” %fifHE, S “Add..” %

& Install

Available Software

Select a site or enter the location of a site,

- B)X]

o

ok with:ﬁ Lvpe or selec

S

Find more software by working with the "Available Software Sikes” preferences,

Mame
| (1) There is no site selected.

Version

Select all ] [ Deselect Al

Dietkails

Show only the latest versions of available software

Group items by category

@

[THide items that are already installed

What is already installedr?

Conkact all update sites during install to find required software

< Back Mext = Finish

Zancel

11
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3. P “Add Repository” XJifHE.

Name F4@ A: ADT

Location "% A\ : https:/dl-ssl.google.com/android/eclipse/, SRR https
Al # N\ http://dl-ssl.google.com/android/eclipse/

LINNEE

& Add Repository E|
ame: |F'.DT | [ Local... ]
Location: |htt|:u|:,|',|'u:||-ssl.gu:n:ugle.cu:um,l'andru:uid,l'eclipse,l' | [ archive, .. ]

® [ ok H Cancel ]

st “OK” 54,

4. I Eclipse R R E URL 756, w8 E T, ~HI: Developer
Tools [JSIEME, EFLEEME, s “Next” $24l.

12
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& Install |-_||'E|[$__<|
Available Software
heck the items that wau wish to install, —
=
Wark with:  |[&DT - https:ffdl-ssl. google. comjandroidfeclipse, w | [ add.., ]

Find more software by working with the "Available Software Sikes” preferences,

Mame Versian
= [w]000 Developer Tools
% Android DOMS 9.0,0,%201101191456-935220
% Android Developrment Tools 9.0.0.v201101191456-93220
% Android Hierarchy Viewer 9,0,0,v201101191456-33220
Select all ] [ Deselect Al 3 items selected
Dekails
Show only the latest versions of available software [THide items that are already installed
Group items by category What is already installed?

Conkact all update sites during install to find required software

©

5. HIL “Install Details” Xf1EHE. rih “Next” 4.

13
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& Install |:|E]

Install Details
Review the items ko be installed, =
=
Mame Version Id
% Android DOMS 9,0.0.%2011011.., com.android.ide.eclipse,ddms . Featur. ..
% Android Development Toals 9,0.0.+2011011... com.android.ide.eclipse, adt.Feature. ...
% Android Hierarchy Viewer 9.0.0.+2011011... com.android.ide.eclipse. hierarchyvie. ..
< e
Size: Unknown
Dietkails
@ [ < Back ]l Mexk = | Finish

6. HIL “Review Licenses” XII&HHE, ZEFE “1 accept the terms of the license
agreements” SIEME. At “Finish” 4%

14
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& Install |:|E]

Review Licenses
Licenses must be reviewed and accepted befare the software can be installed. D -

Licenses: License texk:

Apache License
Mote: joommon-1.0.12.jar is under the B3D license rather thal
Mote: kxmlz-2.3.0.jar is under the BSD license rather than the

{(*1 accept the kerms of the license agreements:

{31 do not accept the kerms of the license agreement:

[
I

@ Mexk = Finish ] [ Zancel

7. BEN N R RE

& Installing Software

i J Installing Software

(RERNRNRNRWRANRNRRRAE )

Fetching com,android.ide.eclipse.ddms_, . .pse.ddms_9.0.0,v201101191456-93220, jar

[ ialwayvs run in backaround:

[Run in Eau:kgru:uund] [ Cancel ] [ Details == ]

8. HHEP I RES I “Security Warning” XFiEHE, ARG AT “OK” %
GRS

15
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& Security Warning |:||E| [z|

Wharning: You are installing software that contains unsigned conkent, The
! authenticity or validity of this software cannok be established, Do wou want ko
continue with the installation?

| ok || cancel || pstaiszs |

0. WM, WU Eclipse, WISIHIEA SR,
& Software Updates b—q

y fou will need to restart Eclipse For the installation changes to take effect. You
x__'\"j maty try ko apply the changes without reskarting, but this may cause errors,

m.gstart Tl | [ ok Mo ] [ﬂpply Changes How

BERELBEINT

1. 5 http://androidappdocs.appspot.com/sdk/eclipse-adt.html 3R 4 Hij Fe 6T
A ADT - Eclipse B2k 220, AT EOfT A . ADT 9.0.0, R4
Huhk k. http://dl.google.com/android/ADT_9.0.0.zip

2. JT4f Eclipse Plugin (AR Z23& 5t #EH, Wi o BT 2N RE IR AR 28 2 26
KL, BARA PR,

& Add Repository E'

Mame: |F'.DT |  Local., |

Location: |jar:File:,I'F:,l'andru:uid,l'.ﬁ.DT_'El.D.El.zip!,l' | [ archive, .. ]
@::l (0.4 ] [ Cancel ]

Fi. Eclipse ADT Bii &

ADT [ Eclipse Plugin Z3&miIh2 J5, JF4h ADT HECE, HEA4AWT:
1. Eclipse )3 J&, #£# Window > Preferences..., 7E4] T JETEHE, %5
Android, nJ DL F):
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& Preferences

| | @ Value must be an existing directary = —

General
Android
ank SOk Location: | [ Browse. ..
Help
Install/Update
Java Target Mame Wendar Flatform  &P...
RunDebug

Tasks

Team

IUzage Data Collector
Yalidation

#ML

android Preferences

Mote: The list of SDK Targets below is only reloaded once wou hik *apply' or 'Ok

L e B B AR

(&3]

Restare Defaults Apply

@ o« [Cam ]

2. {f SDK location F 4 AR[%) Android SDK FITZE [ H =%, #RJ5+% Apply
fell RIAE 2I3RA1 2% SDK 4, K.
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& Preferences

General
Android

ank

Help
Install/Update
Java
FunyDebug
Tasks

Team

IUzage Data Collector
Yalidation

#ML

L e B B AR

(&3]

@

Android

android Preferences

B=1E

SDK Location: |F:'l,andruid'l,andruid-sdk—windows

| [ Browse. ..

Mote: The list of SDK Targets below is only reloaded once wou hik *apply' or 'Ok

Target Mame

Android 1.5
Google APIs
Android 1.6
Google APIs
Android 2.0
Google APIs
Android 2.0.1
Google APIs
android 2. 1-updatel
Google &PIs
Android 2,2
Google APIs
Android 2.3.1
Google APIs

Yendor

Android Open Source Project
Google Inc.
android Open Source Project
Google Inc,
Andraoid Open Source Project
Google Inc.
Andraid Open Source Project
Google Inc.
Android Open Source Project
Google Inc,
android Open Source Project
Google Inc,
Andraoid Open Source Project
Google Inc.

Platform | AF...

1.5

1.5

1.6

1.6

2.0

2.0
2.0.1
2.0.1
2.1-up...
2. 1-up...
2.2

2.2
2.3.1
2.3.1

Lrm RN s B R R I U LT Ny I O R P T

Standard Android platForm 1.6

[Resture Defaults ] [

Apply

]

I

O l [ Zancel

]

2k, Eclipse+ADT [¥4E BT AHEE w2 B i B e EE

A TN
VAR

Android SDK At &

XHEAE R AVD. iTiE AVD, Hl Android Virtual Devices , Android &

B, IREHRA ST A b HI IR o

1. 7 Eclipse "%+ Window-Android SDK and AVD Manager , &7
android-sdk-windows 3Cf1 32 o X iy SDK Manager.exe, A LAE 128040 F

e

18
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% Android SDK and AVD Manager

Wi a5
Installed packages

List of existing sndraid Yirkual Devices located at C:iDocuments and Settings)Administratary, androidiawd

Available packages YD Name Target Narme Platform API Level Mew, ..,
" gavin Android 2.2 2.2 g =
IC. ..
' rrmapi Android 2.2 2.2 g
Delete. ..
Repair,..
Details. ..
Start...

Refrash

s B valid Android Virkual Device, A repairable Andraid Yirkual Device,
¥ An Android Yirkual Device that Failed to load, Click ‘Details' to see the errar,

Ve X A LU BN CZCIES BT AVD, HSLX A AVD AR
224/ Android SDK 774 &1, 1HAZ i1 TP 19 AND AL B 7 43 A58 17 5 2
AT/ home 77, 4p7: C:\Documents and Settings\Administrator\.android\avd .
QI X ] LU 2

2. fE9f Y Android SDK and AVD Manager XfifiHE, ##% Virtual Devices,
e new FH QIR BRI S, MW FEIR:
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& Create new Android Virtual Device (AVD)

rame: |.ﬁ.ndrnid9-.ﬁ.'u'D |
Target: | Android 2.3.1 - API Level 9 v|
S0 Card:
@ size: 100 | [MiE |
) File: | | Browse. ..
Snapshot;
[ ]Enabled
Skir:
(%) Built-in: | Default (WYEASO0)
() Resolution: | | ® | |
Hardware:
Property alue Mew. ..
Abstracked LCD density 240
Max WM application heap size 24 Delete

Crverride the existing AYD with the same name

Create AYVD l [ Cancel

M
/]
+

e Target: SDK [#)27
e SDcard: SD Kk
o Skin: HEIR5EIIZEA

3. Aiili “Create AVD” #4l, 2, 24F “Android SDK and AVD
Manager” X iEHEF EoR,
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% Android SDK and AVD Manager

List of existing sndraid Yirkual Devices located at C:iDocuments and Settings)Administratary, androidiawd

Installedpackages
Available packages AYD Mame Target Name Platfarm AP Level
" gavin Android 2.2 2.2 g =
IC. ..
' rrmapi Android 2.2 2.2 g
" Bndroid3-avD Android 2,3.1 2,31 3 Delete. .
Repair,..
Details. ..
Start...

Refrash

s B valid Android Virkual Device, A repairable Andraid Yirkual Device,

¥ An Android Yirkual Device that Failed to load, Click ‘Details' to see the errar,

PRI RN E 5, #6T REIAT LABEAT Android BN T TT

+. ZE— Android M (Hello, Android World!)

1. BramiH: #1777 Eclipse, #%#¢ File > New > Project > Android Project, H.

PRI AT &

21



no Pain no Gain no Gavin & [F>b T4 : http://blog.sina.com.cn/deaboway http://blog.csdn.net/deaboway

& New Android Project |._| .E”z'
Mew Android Project
Creates a new Android Project resource,
Project name: |HelloAndroidwiorld
Zonkents
@ Create new project in workspace
{:!' Create project from existing source
Use default location
() Create project from existing sample
Samples:
Build Target
Targek Mame Wendor Platform fi1=)
] android 1.5 Android Open Source Project 1.5 3
[] coogle APIs @oogle Inc. 1.5 3
[] android 1.6 Android Open Source Project 1.6 4
[] coogle APIs @oogle Inc. 1.6 4
[] android 2.0 Android Open Source Project 2.0 5
[] Google APIs Google Inc, 2.0 5
[] android 2.001 android Open Source Project 2.0.1 &
[] Google APIs Google Inc. 2.0.1 &
[] android 2.1-updatel  Android Open Source Project 21-upd... 7
[] coogle APIs Google Inc, 21-upd... 7
[] android 2.2 Android Open Source Project 2.2 g
[] coogle APIs @oogle Inc. 2.2 G
Android 2.3.1 Android Open Source Project 2,31 a
[] Google APIs Google Inc, 2,31 a
standard Android platform 2.3.1
Properties
application name: |He||n:n.ﬁ.ndrc'i|:|w:|rld |
Package name: |nrg.deahnway.test |
Create Activiky: |Hella.ﬁ.ndraidWDrld |
Min SOk Version: | |
3
@J [ < Back ][ Mext = ] [ Einish ] [ Zancel

2. pith “Next” , $&7rtnb:
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& New Android Project

Mew Android Test Project

Creates a new dndroid Test Project resource,

[ licreate a Test Project!

Conkent

Idse default location

Browse, ..
Tesk Targek
Build Target
Targek Mame Wendaor Platform AP,
L]
L]
L]
L]
L]
L]
L]
L]
L]
L]
L]
L]
L]
]
Properties

® lext = [ Einish H Cancel ]

3. RXHACHE R, AREMWIH . HE A “Finish” $HIRIA
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& Java - HelloAndroidWorld/src/org/deaboway/test/HelloAndroidWorld. java - Eclipse

File Edit Run Source Refactor Mavigate Search Project  window Help

1 (il B B 0 Q- = C A Nr=a 7 |8 1ava |
¥ 8 :
Package Explor o= Qutline HelladndraidWaorld java
[2 packa lor &3 OF Outl = B || 3] Heloandraidworld ot =B
= <}'=={> o = package org.deshoway.test; =
' El

= & Helloandroidwaorld :
e - #®import android.app.ictivicy;[]

=4 org.deaboway kest
public class HellolndroidWorld extends Activicy |
J*%% Called when the activity iz first created. */
ACverride

2a gen [Generated Java Files]
B Android 2,31

a@ assets public void onCreate (Bundle savedlInstanceltate) |
a@ res super.onCreate (savedInstance3tate)] ;

A AndroidManiFest.ml setContentView (B, layout .maix) }

defaulk, properties
|=| proguard.cfg

[34 Problems &2 @ Javadoc @) Dieclaration & -~ O
0 items

Description Resource Path Locak...  Typ
< | >

T} org.deaboway kest.HelloAndroidWorld, java - Hellogndroidwiorld sre

4. %48 HelloAndroidWorld.java SC£F, W&

package org.deaboway.test;

import android.app.Activity;
import android.os.Bundle;
import android.widget.TextView;

public class HelloAndroidWorld extends Activity {

/** Called when the activity is first created. */

@Override

public void onCreate(Bundle savedlnstanceState) {
super.onCreate(savedlnstanceState);
TextView textView = new TextView(this);
textView.setText("'Hello Android World!');
setContentView(textView);

24
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5. 1247 Android T H : sty T RS, BOERERH: Run->Run, 8%
A BT H SO, i “Run As” XHEHE, 1EH “ Android Application”
st “OK” $ifll

& Run As |:|@

Select a way to run ‘Hellodndroiditorld':

[Eliandroid Application:
Jii android JUnit Test
Java Applet

3] Java Application

Ju JUnit Test

Description

©

6. IZATHCRWIT, AVD INBHESEAT LN, T 054 .
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B 5554: Android9-AVD

= ol B 442

HelloAndroidWorld
Hello Android World!

7. [, Eclipse [ ] & BT ENHISATIN (K — LEARSCAE B, Wik
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& Java - Eclipse

File Edit Run Mavigate Search Project Refactor Window Help
- Brldid-0-Q- HE- dG - B & gava |
o o v
[2ll Problems | @ Javadac Eﬁ';.DecIaration El console 3 BBl ABE-5- 7%
® android . _ _ - _
m [2011-01-30 16:03:47 - 3DE Manager] Warning: Ignoring platform 'android-10': build.prop is
EE [2011-01-30 16:09:04 - 3DE Manager] Warning: Ignoring platform 'android-10': build.prop is
[2011-01-30 16:11:29 - 3DK Manager] Warning: Ignoring platform 'android-10': build.prop is
[2011-01-30 16:15:40 - 3DE Manager] Created AVD 'Android9-AVD' based on Android 2.3.1,
[2011-01-30 16:158:40 - 3DE Manager] with the following hardware config:
[2011-01-30 16:15:40 - 3DE Manager] hw.led.density=240
[2011-01-30 16:158:40 - ADEK Manager] vm.heaplize=2Z4
[2011-01-30 16:37:25 - HellohndroidWorld] ----——————-—-———-———-—————————————
[2011-01-30 16:37:25 - HellobndroidWorld] Android Launch!
[2011-01-30 16:37:25 - HellohindroidWorld] =adb i=s running normally.
[2011-01-30 16:37:25 - HellobndroidWorld] Perforwming org.deasboway.test.HellobndroidiWorld a
[2011-01-30 16:37:25 - HellohndroidWorld] Automatic Target Mode: launching new emulator wi
[2011-01-30 16:37:25 - HellobndroidWorld] Launching a new ewulator with Virtual Device 'An
[2011-01-30 16:37:33 - HelloindroidWorld] New emulstor found: emulator-5554
[2011-01-30 16:37:33 - HellobindroidWorld] Waiting for HOME ('android.process.acore') to be
[2011-01-30 16:35:42 - HellohindroidWorld] WARNING: Application doe=s not specify an API lew
[2011-01-30 18:368:42 = HellodndroidiWiorld] Dbewise APT wersliom I3 9 (Androdd Z:3:1)
[2011-01-30 16:35:42 - HelloindroidWorld] HOHME is up on device 'emxulator-5554!
[2011-01-30 16:358:42 - HellobndroidWorld] Uploading HelloAndroidWorld.apk onto device 'emu
[2011-01-30 1g:358:42 - HellohndroidWorld] Installing HellolndroidWorld.apk...
[2011-01-30 16:39:34 - HellobndroidWorld] Success!
[2011-01-30 16:39:34 - HellohndroidWorld] Starting activity org.desboway.test.HellolAndroid
[2011-01-30 16:39:38 - HelloindroidWorld] ActivityManager: 3tarting: Intent { act=android.
35 >
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